
DATA TRANSFER!
BY RICHARD A. YUEN

VERSION 1.00

System Requirements
·  Microsoft® Windows™ 3.1 or later
·  VBRUN100.DLL Runtime File (Included)
·  ATM (Optional, But Required for Font Use)
·  Mouse (Optional, But Required for Most 

Functions)
·  THREED.VBX (Included)
·  VBDIA.VBX (Included)
·  INSTSCRL.VBX (Included)

VBRUN100.DLL Copyright Notice
The Software is owned by Microsoft or its supppliers 
and is protected by United States copyright laws and 
international treaty provisions.  Therefore, you must 
treat the Software like any other copyrighted material 
except that you may either make one copy of the 
Software for archival or backup purposes or transfer 
the software to a single hard disk.

Installation Information

Run SETUP.EXE to install Data Transfer! Version 
1.0!  You will not have any difficulty because this 
program is almost fool-proof!  Setup will install the 
files into the directory of your choice and the ATM 



fonts will be installed in the same directory.  Please 
install the fonts as your ATM manual instructs.  The 
VBX files will be installed in the Windows System 
directory.  If you happen to receive a "File Not 
Found" Message, put DATREGIS.INF, 
PASSTEXT.DAT, and/or the VBX files in the startup 
or a path directory.

Introduction

Today, August 3, 1992, I have finished the first version of 
Data Transfer! (DatTrans) and the first application that I have 
ever developed for Windows on Visual Basic (or any Windows 
programming language)!  This program has many features that 
makes Windows computing a little bit easier and more fun to 
use.  I'M SORRY, BUT A MOUSE IS REQUIRED FOR 
MOST OF THE FEATURES!  This program has many 
features unique to other utility software, first of all, because it 
has two games.  There are also many other reasons why this 
program is unique to other utility packages.  Read on to find 
out!  If you have never used this program, I'll explain it to you 
in the first section of this manual.  This version is public domain
so you may copy it freely without charge!  For now, all I'm 
going to say is that Data Transfer! is easy to use and learn, and 
if you like to experiment with programs (like I do), stop reading 
right now.

Main Concept
As you may already now, Data Transfer! makes Windows 

computing easier.  Data Transfer! has an oversized calculator (for 
people who can't aim with the mouse very well), a text editor with a 
button bar (for people who hate the menu concept), a drawing 
program (for people who don't like going through the hassle of 
learning a paint program), a program that lets you "look" through your



hard disk (for people who just don't like opening the file manager), a 
clock and an alarm clock (for people who want to know the time while
running DatTrans without using the clock and who need an alarm), a 
calendar (for people who like to look up dates), a personal info 
database (for people who like to keep records), a screen saver (for 
people who like graphical effects and don't want screen burn-in), two 
games (for people who like entertainment programs under Windows), 
and other minor features that make computing more enjoyable.  All 
these features come in this single program and I've never seen all of 
them in any other single program, but I haven't seen to many 
programs so there might be one like this.  This program is public 
domain so you may copy it freely.

Data Transfer!

  The Adventure Begins...Soon!
Click anywhere on this screen to open the screen to bring up the

PassVerify! form (If this is your first time running Data Transfer, the 
password input box will show.  Enter your password, but make sure 
that no one is watching you!  You will now see the Opening Screen.). 
Type your password and press ENTER.  If your password is replaced 
by astericks, don't worry!  I made it that way so your password won't 
be visible to bystanders!  You are now at the Opening Screen!
 
  Opening Screen

The opening screen shows the title of my program, the author's 
name, and various icons dealing with my program.  The title of the 
program will scroll in from the right side of the screen.  To scroll the 
screen more quickly, click on the label on the bottom of the form 
(you've found it if the cursor changes into a "no drop").  If you wish, 
you may draw on the screen in this form, but if you do, you will get to
the main screen of this program, so watch out!  Some of the icons can 
be dragged, but others can be toggled.  That's all there is to do, so let's
move on to the next form.



  Main Screen
The main screen has many different controls.  One of them is 

the User Input box and another is the Program Output box.  By typing
text in the User Input box and pressing the Transfer Data button, your 
text will appear in the program output box.  By pressing the Reverse 
Transfer button, the opposite will take place.  You can also draw on 
the screen with the mouse.  

The main screen also shows many different icons and by 
clicking them, different results will take place.  Try them all!  Some of
them will run another form, others will just display a message in the 
Program Output box.  For example, the trash can icon will erase any 
of the drawing on the screen by the mouse and display a message on 
the screen.  You can make the output in the Program Output box 
transfer to the User Input box by pressing Reverse Transfer. The F1 
icon does nothing much, the Mac icon doesn't do anything either, the 
Mail icon brings up a neat form to show toggling, and the Network 
icon opens the Data Transfer! Register! program.  The Computer icon 
opens the Mix-Up program, but the File Drawer icon brings up the 
personal info database.  The Printer icon brings up the calculator.  The
Paper icon brings up the text editor, the Marker icon brings up the 
drawing program, the disk icon brings up the easy way to look around
on your disks, the clock icon brings up the alarm clock (if clicked 
once, but if clicked twice, it will bring up the calendar), and, as you 
already know, the trash can clears the screen of drawings if click once,
if clicked twice it will bring up the screen saver.  The color changer 
can be called by clicking one of the configure buttons near the Clock 
icon.

The menus have many different commands, in the File menu, 
there are some useful (but mostly unuseful) items.  The New, Open..., 
Print..., Save..., Configure, and Make EXE File... items don't do 
anything useful.  The Exit Data Transfer! item unloads the program 
from memory (exits).  You can exit quickly by pressing F7.

In the Edit menu, all the commands are fairly useful.  The Cut 
command cuts the selected text to the clipboard.  The Copy command 
copies the text to the clipboard, and the Paste command pastes the 
data from the clipboard.  Clear Selected Text clears the selected text 



(obviously!).  Clear Readout clears the Program Output box.  The 
Transfer Data and Reverse Transfer commands do the same thing as 
the buttons with the same name.

In the Programs menu, all the items run the identical program, 
which are explained later.  There are easy shortcuts to run on the 
menu to run each program.

In the Info menu, the Date item display the date in the Program 
Output box, and the Time item display the time in the Program Output
Box.

In the Help menu, the items are pretty useless and don't do much
anything, but you might want to try them anyway.

  Text Editor!
The Data Transfer! Text Editor! basically is an ASCII editor like

Notepad, but it is easier to use and displays more.  The text on the text
editor are already wordwrapped, meaning that if the word is too long 
to stay on the screen, it is put on the next line.

As you may see on the screen, there is a button bar.  By holding 
down one of the buttons, a descriptive message will appear on the 
label next to the button bar.  The Date1 icon displays the date in short 
form (e.g., 3-1-92), the Date2 icon displays the date in long form (e.g. 
Sunday, March 1, 1992), and the Time icon display the time 
(12:45:31).  The Cut icon cuts the selected text to the clipboard, the 
Copy icon copies the selected text to the clipboard, and the Paste icon 
pastes the text from the clipboard.  The Print icon basically prints the 
text out on the default printer, if any.

On the bottom of the screen, you will see three buttons which 
make opening, saving, and exiting easy.  The Open File button will 
open a text file, but it will ask you if you want to save the text on the 
screen (if there is any).  The Save/New button will save the file and 
open a new file.  The exit button exit the program and ask you if you 
would like to save the text, if there is any.

In the File menu, the New command will open a new project, 
the Open... command will open a text file, the Save File... command 
will save the file, the Save As... command will also save the file, and 
Configure will not do anything useful, except tell you my address.  



The Print command will print the file and the Exit command will exit 
the program.  You can also press Alt-F4 to exit the program.

In the Edit menu, the Cut command will cut the text to the 
clipboard, the Copy command will copy the text to the clipboard, and 
the Paste command will paste the text from the clipboard.  The Clear 
Clipboard command will clear the clipboard, the Covert to Lower 
Case will change all of the selected text to lower case letters, and the 
Convert to Upper Case will convert all of the selected text to 
CAPITALS.

In the Info menu, the Date command will display the date, and 
the Time command will display the time.

In the Help menu, none of the command do much.
By double-clicking on the text editor's icon (on the form) you 

will see an About box for the program, and this is true for all other of 
the programs in DatTrans!

  Paint!
Data Transfer! Paint! is really a drawing program, which is very 

simple.  This is the only app in DatTrans that that will allow you to 
size the screen, for obvious purposes.  This program is very simple - 
drag the left mouse button to draw, and click the right button to draw 
a line from the last drawing point to your current position.  This 
program is ONLY FOR MOUSE USERS!  You can drag the icon, or 
you can double-click it to display an about box.  You can also drag 
the finished icon.

The Clear Board button clears all drawings.  The Finished! 
button ends the program.

  DiskInfo!
Data Transfer! DiskInfo! is a program with an easy method of 

searching your hard disk.  The concept is very simple - choose a drive 
from the drop down drive box, select a directory, on the directory list 
box, on the drive by double-clicking it, and choose a file, in the file 
list box, in the directory to exit the program.  Note:  You cannot run a 
program by selecting a file.



  Calc!
Data Transfer! Calc is a very simple calculator that is oversized 

for people who can't aim with their mice and who love large 
calculators.  To enter a number, use this program like a regular 
calculator - punch in the numbers.  Use the operators to Add, Subtract,
Multiply, and/or Divide numbers.  Use the percent sign to find a 
percent of a number by entering the number, pressing the 
Multiplication operator button, entering the percent, and pressing the 
percent sign (i.e., 5 * 6 %).  Use the C button to cancel an equation, 
the CE button to cancel an error, and the Backspace button to remove 
one number at a time.  The Calc! icon brings up the Calc! About box, 
and the Copy button copies the number in the readout box to the 
clipboard.

  Clock! and Alarm Clock!
Data Transfer! Clock! is not an interactive program - it just 

displays the time!
Data Transfer! Alarm Clock! is an interactive program.  By 

clicking on the form, an input box will appear asking you the date in 
this format : hh:mm:ss (i.e., Hours : Minutes : Seconds).  When the 
clock reaches that time, the alarm clock will beep and display a dialog
box signifying that the clock has been set off.

  Super BusinessMan!
Super BusinessMan! is a game in which you are a businessman 

that has to stop this cyborg from destroying your home city.  You will
be able to fly when you get the cape from a block, which you will 
have to hit directly under it.  The gun is also found in a block and you 
must also be directly under it to get the gun.  The gun shoots out four 
bullets at a time, but the cyborg may take many more to stop.  Wait 
until you see the cyborg on the screen before firing.  Your shots must 
be completely accurate to stop the cyborg.  Fortunately, the cyborg 
only moves when you are not moving!

Super BusinessMan will move small steps with the control pad. 
The FlyAwayPad will let you fly only if you have the cape or gun.  He
can only shoot if you have the gun.  The Fire 1! button will fire four 



bullets which might be able to stop the cyborg.  Have fun!
 
  Calendar!

Data Transfer! Calendar! is a program that lets you easily find a 
date.  The top of the calendar shows the month, year, and the days of 
the week.  You can read this calendar the way you would read other 
calendars.  To change the year, click the right arrow on the first 
horizontal scroll bar to advance one year in time, and the left arrow to 
decrease the year shown.  Clicking to the right of the scroll bar 
position will advance the year by a decade, and clicking to the left of 
the position will decrease the year by a decade.  To change the month,
click the right arrow on the second horizontal scroll bar to advance 
one month and the left arrow to decrease the date by one month.  
Clicking to the right of this scroll bar will increase the date by three 
months, and clicking to the left of it will decrease the date by three 
monts.

The Today button will bring you to today's date.
To exit the program, you may either press the Finished! button, 

the Cancel button, or double click a date.
The See Moon Phase! button will bring up a box showing the 

phase of the moon for the date highlighted on Calendar!
If you double click the Calendar! icon, the Calendar! About box 

will appear.

  RecEdit!
Data Transfer! RecEdit! is a personal information database that 

allows you to store records.  The fields include First Name, Last 
Name, Phone Number, Age, and Sex.  Just type information in the 
fields. When you are done, press Add Record to create a new record.  
The program will ask you if you would like to add the information in 
the file, and click on your response.  Repeat these steps until you are 
done, then press Exit to exit the program.  The program will then ask 
you if you would like to save your file, then save your file if you 
wish.  Note:  Don't add any hyphens or parentheses in the Phone 
Number field.

The Next Record button advances to the next record in the file.  



The Previous Record goes back to the record in the file preceding the 
current record.  The Open File button opens a record file.  The Add 
Record button adds a record.  The Delete Record button deletes the 
current record.  The Exit button obviously exits Data Transfer! 
RecEdit!

To display the About box for this program, double click on the 
RecEdit! icon box.

 
 Screen Saver!

Data Transfer! Screen Saver! is a self running program that 
shows a group of lines bouncing and twisting along the edges of the 
form.  As you resize the form, the lines enlarge or shrink accordingly.
Maximize the form for screen saving use.  This can be used for 
enjoyment or to prevent screen burn-in.  There is also another screen 
saver for maximum burn-in prevention under the Programs Menu in 
Data Transfer! called Screen Saver 2! which maximizes the program.

  Mix-Up!
Data Transfer! Mix-Up! is a puzzle program that seperates 

any .BMP file (bitmap) that you supply into 24 parts for you to 
unscramble.  

You select Options Scrammble on Open to scramble the a 
picture when you open it.  After you open a file with the File Open 
command, you remember that you have a great clipboard Graphic that
you can use, so you open it with the File ClipBoard command.  You 
decide that you don't like the way the picture was scrambled so you 
first select Options Show Scrammbling to show the Scrammbling and 
then Options Scrammble.  You select a white puzzle background 
under Options Puzzle Background and a black piece outline by 
selecting Options Piece Outline.  Then you select one of the many 
Pieces options, which each of them does exactly what their 
description is.  You find that the puzzle is so difficult that you need a 
hint by selecting the Hint! command.  You get far into the game, but 
you cannot find some of the pieces, so you select Options Bring 
Pieces to Foreground.  Since you find it impossible to win, you think 



about selecting Options Solve, so the computer will solve the puzzle 
for you, but you decide to select Options Animate to animate the 
solving process.  You click File Exit because you don't want to play 
anymore.  That is a basic puzzle walkthrough, but hopefully, once you
understand the program, you won't have such a difficult time playing! 

  Register!
Also included with this program is Data Transfer! Register!  It allows 

you to print out information about your system to me.  Please put it in a self-
addressed envelope to register the program!  If you don't want to, you don't 
have to, but I will be able to send you program updates.  So, please send in 
your form and your address.

Miscellaneous

  About Boxes
All about boxes do is to display the information about that 

program.  To bring up about boxes, double-click on the icon 
corresponding to that program, somewhere on the form, or, if 
necessary, click on the Help About... item (if there is one) to display 
the about box.

  Mail Form
The Mail Form is an example of toggling (turning something on

or off) which toggles icons.  This is a neat little display which is 
useless, but it's neat to use for a while.

    Background Color Changer
The Background Color Changer can change the backgrounds of 

any of the main forms in Data Transfer!  On the screen, there is a box 
showing the current color, three horizontal scroll bars to select the 
colors, and labels showing the units (maximum 256) of the Red, 
Green, and Blue colors selected.  The total number of colors that can 
be selected are 16.7 million, but if your monitor or graphics card is 
not able to display them, the colors will be dithered and a pattern will 



show up!  To select colors, move the horizontal scroll bars back and 
forth.  The labels to the left of the scroll bars show the amount of 
selected units.  When you have selected the appropriate color, press 
one of the buttons at the bottom of the screen to update the 
background color in one of the forms, and the color in the form will 
change.

  ATM Fonts
Included with this program are the three ATM fonts that I use in

this program.  Please install them in the manner which the ATM 
manual instructs, and please use them, if you would like to, with your 
favorite Windows word processor.

  End Note
Well, that's about it with Data Transfer!  If you find any new 

features with the program that I haven't mentioned in this 
documentation, please feel free to use it - just because its not in the 
document, doesn't mean I didn't put it in!  I can't think of anything 
else to say about the program, but that it's a great way of making 
Windows computing easier.  I hope you will enjoy my program if you
have not already used it, and Have Fun!  If you have a suggestion, 
please write to me at the address that you can find in the Data 
Transfer! Text Editor!, under File Configure.  Oh, and one more thing,
my America Online Screen Name is "AlbertY5"!


